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1Meanings of symbols used

The following table shows the symbols used in this manual, along with descriptions of what they mean.

Indicates something that may cause injury or damage to the projector.

Indicates information that is related to a topic or which may be useful to know.

Indicates a page where a related topic or a more detailed explanation is provided. Click on the page 
number to display that page.

[ (Name) ] Indicates the name of a projector port or a computer menu or item name.
Example: [InputA]  [Start]

CAUTIONCAUTION

TIP
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4Tasks that can be done using EMP Monitor

EMP Monitor lets you carry out operations such as checking the statuses of 
multiple EPSON projectors that are connected to a network at a computer 
monitor, and controlling the projectors from the computer.
Following are brief descriptions of the monitoring and control functions that 
can be carried out using EMP Monitor.
• Registering projectors for monitoring and control

- Projectors on the network can be searched for automatically, and you can 
then select projectors to be registered from the projectors that are detected.

- You can enter the IP addresses for target projectors to register them.
• Registered projectors can also be assigned to groups so that they 

can be monitored and controlled in groups
• Monitoring the statuses of registered projectors

- The power status (ON/OFF) for projectors and problems or warnings 
requiring attention can be checked visually by means of icons.

- You can select groups of projectors or a single projector that you are 
interested in, and then check the cumulative lamp operating time or the 
details of information such as input sources, problems, and warnings for 
these projectors.

•  Controlling registered projectors
- Projectors can be selected in groups or as single projectors, and you can 

then carry out operations for the selected projectors such as turning the 
power on and off and switching their input sources. 

- Web control functions can be used to change the settings in the projector's 
configuration menu. 

- If there are certain control actions which are carried out regularly at 
particular times or on particular days, you can use "Timer Settings" to 
register timer settings.

• E-mail notification function settings
You can set e-mail addresses to which notifications are sent if a status 
requiring attention, such as a problem, occurs with a projector that has been 
registered.

System configuration example

Projector A

Projector B

Group B

I want to turn on the 
power for Group A 
projectors.

EMP Monitor

Group A

TIP

To enable projectors to be monitored and controlled even when they 
are in standby mode*, make the following settings at the projectors. 
The settings that need to be made will vary depending on the projector 
you are using. 
s "Configuration menus" in the projector's User's Guide. 
•  Set "Network Monitoring" to "ON".
•  Set "Standby Mode" to "Network ON".

* When the projector's  (Power) indicator is lit orange
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Compatible computers

Macintosh computers cannot be used.

* Operations carried out at the computer may become slow depending on the 
number of projectors being managed. If this happens, use a computer with 
higher specifications.

* EMP Monitor cannot be used in environments which do not allow pings to 
be transmitted.

Installing EMP Monitor

When you are using Windows 2000/Windows NT4.0/Windows XP/
Windows Vista, you must have administrator authority in order to install 
EMP Monitor.

When the language selected for the EMP Monitor installation varies from 
that of the OS being used, the EMP Monitor screens may not be displayed 
correctly.

PROCEDURE

Turn the computer on.
To prevent problems from occurring during the installation, we 
recommend that you terminate all resident applications that can 
be ended.

Load the following CD-ROM in your computer: 
"EPSON Projector Software for Monitoring" or 
"Epson Projector Software for Meeting & 
Presentation".
The installer automatically starts up.

From here, continue with the installation by following 
the on-screen messages.

OS Windows 98 Second Edition SP1
Windows Me
Windows NT4.0 SP6
Windows 2000 Professional SP4
The following 32-bit operating systems:
Windows XP Home Edition SP1 or later
Windows XP Professional SP1 or later
Windows Vista Home Basic
Windows Vista Home Premium
Windows Vista Business
Windows Vista Ultimate
Windows Vista Enterprise
• Internet Explorer Ver. 5.0 or later must be installed.

CPU Pentium MMX 166 MHz or higher (Pentium II 233 MHz 
or higher recommended)

Memory 
capacity

64 MB or more (128 MB or more recommended)

Free hard disk 
space

50 MB or more

Display SVGA (800×600) or higher resolution, 32 bit or higher 
display colour

1

2

3
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Limitations imposed by a Windows Vista 
environment

When using EMP Monitor under Windows Vista, note the following 
limitations.
• You must have administrator authority in order to use "Register at 

startup" on the "Environment setup" screen of EMP monitor.
s"Monitoring using the system tray" p.22

• Even after EMP monitor has been uninstalled, the settings and log 
information will remain on the hard disk. If this information is no longer 
required, you may delete the "EMP Monitor V4.22" folder. Provided the 
default settings were used at installation, this folder can be found at:
"C:\Users\(User Name)\AppData\Local\VirtualStore\Program 
Files\EPSON Projector\EMP Monitor V4.22"

Before starting operations

Check the following points before starting up EMP Monitor.
• EMP Monitor must be installed on the computer to be used for 

monitoring and control.
• The computer and the projectors must be connected to the network.
• If using Windows 2000, Windows NT4.0, Windows XP, or Windows 

Vista, the computer must be started up in Administrator mode.

When using EMP-6000/82/62/828/821/81/61
• A commercially-available serial ⇔ TCP/IP conversion adapter and a 

connection cable are required in order to use EMP Monitor.  
s"Standby mode" in the projector's User's Guide

• Make the settings for the serial ⇔ TCP/IP conversion adapter before 
connecting to the projector.



7Registering and deleting projectors for monitoring

This operation is carried out when starting EMP Monitor for the first time after 
it has been installed and when you would like to add projectors. Once a 
projector has been registered, the status for the projector will be displayed 
automatically each time EMP Monitor is started from that point onwards.

Starting EMP Monitor

PROCEDURE

Click [Start] - [Programs] (or [All Programs]) - [EPSON 
Projector] - [EMP Monitor V4.22] in that order to start 
EMP Monitor.

The main window will be displayed.

The operations to register projectors using the automatic search will 
vary depending on where the projectors are connected to in the 
network.
•When registering a projector that is located in the same segment 
that the computer the EMP Monitor is installed in is associated 
with. s"Registering projectors using automatic search (Searching 
for and registering projectors that are located in the same segment)" 
p.8 

•When registering projectors that are in multiple segments of the 
network s"Setting the range of addresses to do an automatic 
search and registration" p.10

1

2
"Grouping view"
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Registering projectors using automatic search 
(Searching for and registering projectors that are 
located in the same segment)

PROCEDURE

f Procedures for automatic search

Right-click in "Grouping view" and select "New" - 
"Projector (automatic search)".
The "Create new projector (automatic registration)" window 
will be displayed.
• If "Detail list view" is displayed, select "New" - "Projector 

(automatic search)" from the "Edit" menu.

Click [Search]. 
Automatic search will be carried out, and the names of the 
projectors that have been detected will be displayed.
• If a projector does not appear in the list, use "Registration by 

specifying an IP address (Manual registration)". sp.12

1

2

TIP

• You can also carry out this operation by selecting "Projector 
(automatic search)" from "New" in the "Edit" menu.

• Projectors that are using a serial ⇔ TCP/IP conversion adapter 
cannot be detected.
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f Procedures for registration

Select the projector(s) to be registered, and then click 
[Edit].
The following window will be displayed.
Make the necessary settings while referring to the following 
table.

After entering the details, click [Register] to start the 
registration. When the message is displayed, click 
[OK].
To continue registering other projector(s), repeat Steps 3 and 4.

Display name Enter the name of the projector(s) to be displayed in 
"Grouping view" or "Detail list view".
Up to a maximum of 32 bytes can be entered. 
A space cannot be used as the first character.

Display icon Select the icon(s) to be displayed in "Grouping view" 
or "Detail list view".

Parent group Select when registering a projector in a group.
If no groups have been created, this cannot be 
selected. s"Registering several projectors to a 
monitoring group all at once" p.13

3
Projector 
name

This shows the name that has been registered on the 
projector. 

IP address This shows the IP address for the registered projector.
Use Serial ⇔ 
TCP/IP 
conversion 
adaptor.

This cannot be selected when registering projectors 
using automatic search.

Port Number This cannot be selected when registering projectors 
using automatic search.

Monitor 
Password 

If a Monitor Password has been set for the projector, 
be sure to enter the Monitor Password that has been 
set. If the correct password is not entered at this time, 
it will not be possible to monitor and control the 
projector even though it is registered.

Description You can enter some kind of memo about the projector. 
The details you enter here will be displayed at the 
projector properties.
Up to a maximum of 60 bytes can be entered.

Monitor Select this when you want monitoring to start.

4

TIP

Projectors that have been registered using automatic search are 
searched for again by projector name each time EMP Monitor is 
started.
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To end the registration operation, click the  in the 
top-right corner of the window or click [Cancel]. 
The icon(s) of the projector(s) you registered will be displayed 
in "Grouping view" or "Detail list view".
Refer to "Monitoring window layout" for details on using the 
"Grouping view" and "Detail list view".  sp.17

Setting the range of addresses to do an automatic 
search and registration

PROCEDURE

f Procedures for automatic search

Right-click in "Grouping view" and select "New" - 
"Projector (automatic search)".
The "Create new projector (automatic registration)" window 
will be displayed.
• If "Detail list view" is displayed, select "New" - "Projector 

(automatic search)" from the "Edit" menu.

Select the "Specify an address range and search" 
check box and then enter the starting address and 
ending address in the range.

Click [Search]. 
Automatic searching will be carried out, and the names of the 
projectors that have been detected will be displayed.

5

TIP

Projectors that are using a serial ⇔ TCP/IP conversion adapter 
cannot be detected.

1

2

3
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f Procedures for registration

Select the projector(s) to be registered, and then click 
[Edit].
The following window will be displayed.
Make the necessary settings while referring to the following 
table.

After entering the details, click [Register] to start the 
registration. When the message is displayed, click 
[OK].
To continue registering other projector(s), repeat Steps 4 and 5.

To end the registration operation, click  in the top-
right corner of the window or click [Cancel]. 
The icon(s) of the projector(s) you registered will be displayed 
in "Grouping view" or "Detail list view".
Refer to "Moitoring window layout" for details on using the 
"Grouping view" and "Detail list view". sp.17

Display name Enter the name of the projector(s) to be displayed in 
"Grouping view" or "Detail list view".
Up to a maximum of 32 bytes can be entered. 
A space cannot be used as the first character.

Display icon Select the icon(s) to be displayed in "Grouping view" 
or "Detail list view".

Parent group Select when registering a projector in a group.
If no groups have been created, this cannot be 
selected. s"Registering several projectors to a 
monitoring group all at once" p.13

4
Projector 
name

This shows the name that has been registered on the 
projector. 

IP address This shows the IP address for the registered projector.
Use Serial⇔ 
TCP/IP 
conversion 
adaptor.

This cannot be selected when registering projectors 
using automatic search.

Port Number This cannot be selected when registering projectors 
using automatic search.

Monitor 
Password

If a Monitor Password has been set for the projector, 
be sure to enter the Monitor Password that has been 
set. If the correct password is not entered at this time, 
it will not be possible to monitor and control the 
projector even though it is registered.

Description You can enter some kind of memo about the projector. 
The details you enter here will be displayed at the 
projector properties.
Up to a maximum of 60 bytes can be entered.

Monitor Select this when you want monitoring to start.

5

6
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Registration by specifying an IP address (Manual 
registration)

PROCEDURE

Right-click in "Grouping view" and select "New" - 
"Projector (manual registration)".
The following window will be displayed.
• If "Detail list view" is displayed, select "New" - "Projector (manual 

registration)" from the "Edit" menu.

Enter the IP address of the projector to be registered 
in the "IP address" box and then click [Search]. When 
the message is displayed, click [OK]. 
• If using a serial ⇔ TCP/IP conversion adapter and cable to connect 

the projector, select "Use Serial ⇔ TCP/IP conversion adaptor". 
Enter the port number in "Port Number" and then click [Search]. 

After searching is complete, enter the information for 
the projector to be registered while referring to the 
table below.

1

TIP

You can also carry out this operation by selecting "Projector (manual 
registration)" from "New" in the "Edit" menu.

Display name Enter the name of the projector(s) to be displayed in 
"Grouping view" or "Detail list view".
Up to a maximum of 32 bytes can be entered. 
A space cannot be used as the first character.

Display icon Select the icon(s) to be displayed in "Grouping view" 
or "Detail list view".

Parent group Select when registering a projector in a group.
If no groups have been created, this cannot be 
selected. s"Registering several projectors to a 
monitoring group all at once" p.13

Projector 
name

This shows the name that has been registered on the 
projector. 

IP address This shows the IP address that you entered in step 2.

Use Serial ⇔ 
TCP/IP 
conversion 
adaptor.

Select this if using a serial ⇔ TCP/IP conversion 
adapter to connect the projector.

Port Number If using a serial ⇔ TCP/IP conversion adapter to 
connect the projector, enter the port number.

2

3
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After entering the details, click [Register] to start the 
registration. When the message is displayed, click 
[OK].
The icon(s) of the projector(s) you registered will be displayed 
in "Grouping view" or "Detail list view".

Registering several projectors to a monitoring group 
all at once

Projectors that have been registered can then be registered together into 
different groups so that they can be monitored and controlled together.
Furthermore, if you select one of the registered groups as the "Parent 
group", monitoring and control operations can be carried out for all 
projectors in that "Parent group".
A "Parent group" can be set for other parent groups, so that a hierarchical 
group arrangement such as the following can be created.

First, create the registration groups, and then register projectors into the 
groups that have been created.

Monitor 
Password 

If a Monitor Password has been set for the projector, 
be sure to enter the Monitor Password that has been 
set. If the correct password is not entered at this time, 
it will not be possible to monitor and control the 
projector even though it is registered. If using a serial 
⇔ TCP/IP conversion adapter to connect the 
projector, the Monitor Password security function 
cannot be used.

Description You can enter some kind of memo about the projector. 
The details you enter here will be displayed at the 
projector properties.
Up to a maximum of 60 bytes can be entered.

Monitor Select this when you want monitoring to start.

4

Branch A 

Branch B

Branch C 

Showroom

Convention hall

Conference room 

Reception room

Conference room 

Showroom A

Projector01 

100
101
102

201

No1 

No2 

No3 

Showroom B No4 

No5 Lobby

Projector02 

103

Room 1 
Room 3 

202
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PROCEDURE

Right-click in "Grouping view" and select "New" - 
"Group".
The following window will be displayed.
Make the necessary settings while referring to the table below.
• If "Detail list view" is displayed, select "New" - "Group" from the 

"Edit" menu.

After entering the details, click [Register] to start the 
registration. When the message is displayed, click 
[OK].
The icon(s) of the projector(s) you registered will be displayed 
in "Grouping view" or "Detail list view".

Right-click the projector icon(s) to register to the 
group you have created in "Grouping view" or "Detail 
list view", and select "Edit".

In the "Edit projector" window, select the group name 
to use for registering in "Parent group" and then click 
[Change].
The status of the group registration will be displayed as an icon 
in "Grouping view" or "Detail list view".

Group name Enter the name of the group(s) to be displayed in 
"Grouping view" or "Detail list view".
Up to a maximum of 32 bytes can be entered. 
A space cannot be used as the first character.

Display icon Select the icon(s) to be displayed in "Grouping view" 
or "Detail list view". 

Parent group This selects the parent group. If no groups have been 
created, this cannot be selected. 

Monitor Select this to monitor all projectors that have been 
registered in the group. If this is not selected, the 
settings made when the individual projectors were 
registered will be used.
It cannot be set when creating a new group.

1

TIP

You can also carry out this operation by selecting "Group" from 
"New" in the "Edit" menu.

2

3

TIP

You can also carry out this operation by selecting "Edit" from the 
"Edit" menu.

4

TIP

The registration details can also be checked using "Projector list" in 
the "View" menu.
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If the projector name or IP address changes after 
registration

f For projectors that have been registered manually

PROCEDURE

Right-click on a projector icon in "Grouping view" or 
"Detail list view" and select "Monitoring disabled".  
Then right-click the projector icon again and select 
"Edit".

If only the projector name has been changed, click 
[Search] in the "Edit projector" window that is 
displayed. 
If the IP address has been changed, enter the new IP 
address in the "IP address" box and then click 
[Search]. When the message is displayed, click [OK].

When the display returns to the "Edit projector" 
window, click [Change].

f For projectors that have been registered using automatic 
search

PROCEDURE

Delete the projector(s) whose name or IP address has 
been changed in "Grouping view" or "Detail list 
view". sp.16

Carry out automatic search to re-register the 
projector(s). sp.8

1

TIP

You can also carry out these operations by using the "Edit" menu.

2

3

1

2
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Cancelling (deleting) projector registrations

The registrations for projectors can be deleted if they are no longer 
required for monitoring or control using EMP Monitor.

PROCEDURE

Right-click the icon for the projector or group that is to be 
deleted in "Grouping view" or "Detail list view" and select 
"Delete".
When the message is displayed, click [OK].
More than one projector can be selected for deleting by selecting in 
"Grouping view" or "Detail list view".
The methods of selecting more than one projector at the same time are as 
follow.
• If you select a group icon in "Grouping view", all projectors that have 

been registered in that group will be deleted at the same time.
• Hold down the [Ctrl] key on the keyboard while clicking on the desired 

icons.
• Use drag and drop to select a range of desired icons.

TIP

You can also carry out this operation by selecting "Delete" from the 
"Edit" menu.



17Monitoring window layout

You can monitor using either of the window layouts below.
• "Grouping view"

This view lets you check the status of group registrations in a hierarchical 
diagram.

• "Detail list view"
This view lets you display the status of each projector as a list so that the 
projectors can be checked in detail. You can also display specific items as a 
list, and sort display items using a specific row as a sort key.

f How to switch views

"Grouping view" and "Detail list view" are switched as follows.

PROCEDURE

Click the "View" menu, and select "Grouping view" or 
"Detail list view".

Monitoring using "Grouping view"

f Meanings of "Grouping view" icons

In "Grouping view", the patterns on the icons indicate the statuses of the 
projectors.
.

"Grouping view" "Detail list view"

"Grouping view"

If the group 
icons are round 
in shape, it 
indicates that 
there is another 
level below 
them. s p.18
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The icon patterns and their meanings are explained below. *1 When "Temperature level display group view" is set to "On" at 
"Environment setup" in the "Tool" menu, an icon indicating the internal 
temperature of the projector will be displayed on top of the projector 
icon. The default setting is "Off". As you can get an idea of how the 
temperature inside the projector is increasing when the internal 
temperature level is displayed, you can make improvements to the 
projector's operating environment before a high internal temperature 
alarm occurs or the temperature becomes abnormally hot. sp.23

*2 Check the following items.
• Check that the projector's power is turned on. 
• Check that the LAN cable is connected.
• Check that "Network Monitoring" is set to "ON" or "Standby Mode" 

is set to "Network ON" in the projector's configuration menu.
*3 Check that the projector has been correctly connected to the network.

f Using the icons in "Grouping view"

The following icon operations can be carried out in "Grouping view".
• Expanding and collapsing icons

Each time you double-click a group icon, the icons for the projector that 
have been registered in that group are displayed or hidden.

• Moving icons
To change the position of an icon within "Grouping view", simply drag 
and drop the icon to be moved.

Group

No warnings or problems
All projectors in the group are normal.
Warning or problem
A projector in the group has a warning or problem 
status.
Notification
A projector requiring immediate attention has been 
detected within the group.
Monitoring disabled
The projector is not being monitored. If you right-
click the icon and select "Monitoring enabled", the 
projector will be added to the projectors that are 
being monitored.

Data being updated

Projector

No warnings or problems*1

Warning or problem

Notification

Monitoring disabled

Data being updated 

Network error (monitor password authentication 
error) 
No Monitor Password was entered when the projector 
was registered, or an incorrect Monitor Password was 
entered. sp.9, 11, 13

Network error (TCP connection error)*2

Network error (ESC/VP.net communication 
error)*3

TIP

The projector information that is generated when a problem is 
detected is stored until EMP Monitor is closed. The EMP Monitor 
displays will not be updated automatically even if the projector status 
returns to normal. Click [Refresh] in the main window to update the 
status.



19Monitoring window layout

Monitoring using "Detail list view"

f Meanings of "Detail list view" icons

The status of registered projectors is displayed as a list in "Detail list view" 
regardless of which groups the projectors belong to. 

The icon patterns and their meanings are explained below.

Type: Displays the projector status.

No warnings or problems*1

Warning or problem
An error has occurred on the projector.
Notification
The projector requires immediate attention.

Monitoring disabled
The projector is not being monitored. If you right-click 
the icon and select "Monitoring enabled", the projector 
will be added to the projectors that are being monitored.

Data being updated 

Network error (monitor password authentication 
error) 
No Monitor Password was entered when the projector 
was registered, or an incorrect Monitor Password was 
entered. sp.9, 11, 13

Network error (TCP connection error)*2

Network error (ESC/VP.net communication error)*3

Group name: When projectors are registered to a group, the name of 
the group that the projector belongs to is displayed.

Display name: Shows the display name.
Power: Shows the power on status for the projector.

Power on and normal 
status

Power on and 
abnormal status

Power off and normal 
status

Power off and 
abnormal status

Lamp Hours: Shows the lamp operating time for the projector.
Temperature level: The following five icons display the differing 

internal temperature status of the projector.
Internal temperature 
normal

High-temperature 
warning

Internal temperature 
normal

Internal temperature 
error

High-temperature 
warning
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*1 When "Temperature level display group view" is set to "On" at 
"Environment setup" in the "Tool" menu, an icon indicating the internal 
temperature of the projector will be displayed on top of the projector 
icon. The default setting is "Off".

*2 Check the following items.
• Check that the projector's power is turned on. 
• Check that the LAN cable is connected.
• Check that "Network Monitoring" is set to "ON" or "Standby Mode" 

is set to "Network ON" in the projector's configuration menu.
*3 Check that the projector has been correctly connected to the network.
*4 You can display the "Replace Lamp" warning at any time preset in 

"Environment setup" in the "Tool" menu.

f Selecting display items
You can select only the required items to be displayed in "Detail list view".

PROCEDURE

Select "Option" from the "View" menu.
The "Option" window will be displayed.

Error information: Shows a notification or warning/problem status 
using the following icons.

Clean Air Filter 
Notice Lamp Error

Replace Lamp*4 Lamp failure at 
power on

High-temperature 
warning

High internal 
temperature error

Replace Air Filter Internal Error

No Air Filter Fan error

Low Air Flow Sensor error

Air Flow Sensor Err. Supply System Error 
(Ballast)

Low air flow error Auto Iris Error

Air filter air flow 
sensor error Other error

Lamp Cover Open

TIP

• The projector information that is generated when a problem is 
detected is stored until EMP Monitor is closed. The EMP Monitor 
displays will not be updated automatically even if the projector status 
returns to normal. Click [Refresh] in the main window to update the 
status.

• Detectable error information differs with the projector you are using. 

1
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Select the check box of the item you want to display.

Click [OK].

When all of the details of the item cannot be displayed 
in "Detail list view", drag the boundary line on the 
right of the item name so that the view is extended to 
the desired width.

f Sorting lists

You can sort detailed lists by using a specific row as a sort key, such as 
projector name order or IP address order.

PROCEDURE

Click the item name of the row you want to use as the sort 
key.

Searching for desired icons (Projector list)

The "Projector list" feature is useful for searching in lists when many 
groups and projectors are registered and the icon you are looking for is not 
displayed on screen.  

PROCEDURE

Select "Projector list" from the "View" menu. 

The "Projector list" lets you check the registration details for groups in a 
hierarchical diagram. When you click on an icon, "Grouping view" and 
"Detail list view" are scrolled so that the selected icon is displayed in the 
window.

2

3

4

With "Projector list", temperature 
level icons are not displayed 
regardless of the setting of 
"Temperature level display group 
view" at "Environment setup". 
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Monitoring using the system tray

The projector statuses are always displayed as icons in the system tray, 
even when "Grouping view" or "Detail list view" is not always displayed, 
and the statuses can be checked by the icon patterns. 
When the configuration menus are set using the following operations, an 
icon appears in the system tray and the status can be monitored by means 
of the icon's pattern.

PROCEDURE

Select "Environment setup" from the "Tool" menu.
The "Environment setup" window will be displayed.

Select "Resident in the task tray".

Click [OK].

 : No problem

 : Problem

1

2

3

TIP

• Right-click the icon in the system tray to open a pop-up menu to 
select the "Open the main screen" or "Exit".

• If "Register at start up" in the "Environment set up" is selected, 
EMP Monitor starts automatically when the computer's power is 
turned on. When using EMP Monitor under Windows Vista, you 
must have administrator authority in order to use this function.
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Displaying projectors with problem or warning 
statuses in a list

You can display a list of only the projectors which have a problem or 
warning status.

PROCEDURE

Select "Warning and Error Projector list" from the "View" 
menu.
The following "Warning and Error Projector list" window will be 
displayed.

The icon patterns and their meanings are explained below.

If you move the 
mouse pointer over 
the icon, details of 
the error and the 
remedy will be 
displayed.

If you double-click in 
a line, the properties 
for that projector will 
be displayed. 
s p.25

Type: Shows the group or projector status. sp.17

Display name: Shows the display name.

Power: Shows the power on status for the projector.

Power on and normal 
status

Power on and 
abnormal status

Power off and normal 
status

Power off and 
abnormal status

Lamp Hours: Shows the lamp operating time for the projector.

Source: Shows the input source that has been selected for the projector.

Computer or 
Computer1 Video(BNC)

Computer2 DVI or HDMI 
(Digital)

BNC D-Video

S-Video EasyMP

Video(RCA)

Temperature level: The following five icons display the differing 
internal temperature status of the projector.

Internal temperature 
normal

High-temperature 
warning

Internal temperature 
normal

Internal temperature 
error

High-temperature 
warning
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*You can display the "Replace Lamp" warning at any time preset in 
"Environment setup" in the "Tool" menu.

Checking properties in detail

You can check the properties of groups and projectors in detail.

f Displaying group properties

You can use either of the following methods to display the properties.
• Displaying the properties for all groups in "Grouping view"

Right-click in "Grouping view" and then select "Property".
• Displaying properties for specified groups

Right-click an icon in "Grouping view" and then select "Property".

Error information: Shows the warning or problem status using the 
following icons.

Replace Lamp* Lamp Error

High-temperature 
warning

Lamp failure at 
power on

Replace Air Filter High internal 
temperature error

No Air Filter Internal Error

Low Air Flow Fan error

Air Flow Sensor Err. Sensor error

Low air flow error Supply System Error 
(Ballast)

Air filter air flow 
sensor error Auto Iris Error

Lamp Cover Open Other error

TIP

Detectable error information differs with the projector you are using. 

If you double-click 
in a line, the 
properties for that 
group or projector 
will be displayed.
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f Displaying projector properties

Right-click on a projector icon in "Grouping view" or "Detail list view" 
and select "Property".

Displaying and deleting logs

In your web browser, you can check a transmission log of content such as 
what has been controlled by the EMP Monitor, projector errors. You can 
delete logs once you have checked them.

f Displaying logs

PROCEDURE

Select "Log" - "show" from the "View" menu.
The web browser will open and the communication logs up until that 
time will be displayed.

f Deleting logs

PROCEDURE

Select "Log" - "Delete" from the "View" menu.
When the confirmation message is displayed, click [OK].
All logs will be deleted and details of EMP Monitor control 
operations and details of projector errors from that point onward will 
be recorded in a new log.

Displays the 
projector firmware 
version.

TIP

When "Log output" is set to "On" at "Environment setup" in the 
"Tool" menu, transmission logs are stored. The default setting is 
"Off".
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Carrying out control using control buttons

Click the icon of a projector to be controlled in "Grouping view" or "Detail 
list view", and click a control button to enable control of only that selected 
projector.
You can also enable control of all selected projectors by selecting more 
than one projector in "Grouping view" or "Detail list view" and clicking a 
control button. The methods of selecting more than one projector at the 
same time are as follow.
• If you select a group icon in "Grouping view", all projectors that have

been registered in that group and that are set to be monitored can be 
controlled at the same time.

• Hold down the [Ctrl] key on the keyboard while clicking on the desired 
icons.

• Use drag and drop to select a range of desired icons.

The following table shows the meanings of the control buttons.

Control buttons

Power On Turns the projector power on.

Power Off Turns the projector power off.

Switch source
Computer 1

Switches the input source to the [Computer1] port 
or [Computer] port.

Switch source
Computer 2

Switches the input source to the [Computer2] port.

Switch source 
BNC

Switches the input source to the [BNC] port.

Switch source 
S-Video

Switches the input source to the [S-Video] port.

Switch source 
Video(RCA)

Switches the input source to the [Video] port or the 
[Video 2] port.

Switch source 
Video(BNC)

Switches the input source to the [Video1] port.

Switch source 
DVI, HDMI

Switches the input source to the [DVI] port or 
[HDMI] port.

Switch source 
D-Video

Switches the input source to the [D4] port.

Switch source 
EasyMP

Switches to EasyMP or EasyMP.net. 
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Carrying out control using a web browser (Web 
control)

You can use the computer's web browser to change the configuration menu 
settings for projectors.

PROCEDURE

Right-click on the icon of a projector to be controlled 
in "Grouping view" or "Detail list view" and select 
"Web control".

The web browser will open and the Web control 
window will be displayed.

Web control lets you set the same details as the configuration menu for the 
projector. Refer to the Projector's User's Guide for details on the 
configuration menu.

TIP

• Some connected projectors may not be equipped with all of the 
above ports or functions. If you click a button for a port or function 
that is not available, nothing will happen.

• You can select objects to be controlled and use the control buttons to 
carry out control operations even when the following are being 
displayed. sFor details on each display p.23, 24
- Group properties
- Projector properties
- Warning and Error Projector list (Control operations can only be 

carried out for projectors with a warning status.)

1

2

TIP

You can select projectors and right-click on them to select "Web 
control" even when the following are being displayed.
• Group properties sp.24
• Warning and Error Projector list (Control operations can only be 

carried out for projectors with a warning status.) sp.23
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Carrying out control using timer settings

This is useful for carrying out certain control operations such as turning a 
projector's power on and off at specified times every day or every week.
Timer settings can be carried out either for a single projector only, or all at 
once for all projectors in a group.

PROCEDURE

Select "Timer" - "Timer Settings" from the "Tool" 
menu.
The following window will be displayed and you can then 
check the timer setting status.

The details that can be checked and operations that can be carried out at this 
time are given below.

1

The colours in the lines of the list have the following meanings:
: Current day's timer setting
: When some of the projectors in the group have timer setting 
enabled and others have it disabled for the current day's timer 
setting

: When the current day's timer setting is a disabled setting
: Timer setting for a day other than the current day

Projectors
Selects a group or projector to check the status of.
When a group is selected, the timer setting statuses for 
all projectors in that group are displayed.

Date

Shows the current day in a red box.
Days for which timer settings have been made are shown 
in bold.
Click  or  to switch to the calendar for the 
previous or next month.

Timers Shows a list of the timer settings.

[Enabled]
[Disabled]

Switches the timer settings that have been selected from 
the timer list between enabled and disabled.

[Add] Registers new timer settings.

[Edit]

Lets you change the timer settings that have been 
selected from the timer list.
If a group has been selected for status checking, the 
settings cannot be changed.

[Delete] Lets you delete timer settings that have been selected 
from the timer list.
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f Procedures for new timer settings

When you click "Add", the following window is 
displayed and the new timer settings are applied.

At "Operation", you can carry out the operations of turning the 
power on and off and switching the input sources, similarly for 
the control buttons on the main window. If you set the input 
source switching, the projector's power will turn on at the timer 
start time even if it is not on at the time. Because of this, it is not 
necessary to make two separate timer settings for turning the 
power on and switching the input source.

After completing the timer settings, click [OK].
The timer settings that have been made will be registered and 
they can be checked in the displayed timer list.

2

3

TIP

You can enable and disable all of the timer settings that have been 
registered. Select "Timer" - "Enable" or "Disable" from the "Tool" 
menu.
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The mail notification function can be used to send corresponding notification 
messages to a preset e-mail address when a projector that is connected to the 
network assumes a certain status, or if it experiences a problem or warning. By 
using this function, the operator can be notified of a projector's status or 
problems even when the operator is in a different location from the projectors.

PROCEDURE

Select "Mail notification function" from the "Tool" 
menu.

The "Set mail notification function" window will be 
displayed.
Set the following parameters.

TIP

• Up to three addressees (destinations) can be registered and 
messages can be sent to all of them at once. 

• If a critical problem develops with a projector which causes it to 
suddenly stop working, it may not be possible for the projector to 
send a message notifying an operator of the problem.

• If "Standby Mode" is set to "Network ON" or "Network 
Monitoring" is set to "ON" in the projector configuration menus, 
you can monitor the projector even when it is in standby mode 
(when its power is turned off). sProjector's User's Guide

• On some projectors, the mail notification function can be set in the 
configuration menu. When notification messages are set to be sent 
in the projector's configuration menu, both the settings in the 
configuration menu and settings made on EMP Monitor are 
functional.

• Detectable status with the mail notification function differs with the 
projector you are using.

1

Mail notification 
function

Set to "ON" to use the mail notification function.

SMTP server 
IP address

Enter the IP address of the SMTP server. 
Up to a maximum of 255 bytes can be entered.

When you change a port number of the SMTP 
server, specify this port number. The default value 
is "25".
You can enter a valid number from 1 to 65535.

Sender mail 
address

Enter the sender's e-mail address. Up to a 
maximum of 255 bytes can be entered. 

Recipient 
mail address 1

Specify the destination addresses for the 
notification e-mail. Up to three destinations can be 
set. Up to a maximum of 255 bytes can be entered.

Recipient 
mail address 2

Recipient 
mail address 3

2
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Click [Notification event] and check the items for mail 
notification in the window that appears.

Click [OK].
When the "Set mail notification function" window appears 
again, repeat Steps 3 and 4 to set the events to be notified.

When the setup is complete, click [OK].3

4

5
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If the projector experiences a problem or enters a status requiring attention, 
an e-mail like that shown below is sent to the address specified for 
"Recipient mail address".
If there is more than one problem, warning, or status, the corresponding 
messages are output to separate lines.

The details contained in the e-mail message can consist of the following.

Messages to inform that the projector has recovered from the error or 
warning statuses are sent.

Item Details shown
E-mail subject [Display name displayed in "Grouping view" or 

"Detail list view"] Projector status notification

Body <Display name displayed in "Grouping view" 
or "Detail list view"> has entered the following 
status.
<Problem/warning/status message (Please see 
the table below)>

Message Remedy
Internal Error "Reading the indicators"

s"Reading the Indicators" in the projector's 
User's GuideFan error

Sensor error

Lamp Cover Open

Lamp failure at power on

Lamp Error

High internal 
temperature error

Low air flow error

Air filter air flow sensor 
error

High-temperature 
warning

"Reading the indicators"
s"Reading the Indicators" in the projector's 
User's GuideReplace Lamp

Replace Air Filter

No Air Filter

Low Air Flow

Air Flow Sensor Err.

Clean Air Filter Notice

No signal No image signals are being received by the 
projector. Check the connection status and 
check that the power for the connected 
equipment is turned on.

Other error Stop using the projector, disconnect the 
power cable from the electrical outlet, and 
contact your local dealer or the nearest 
address provided in the Support and Service 
Guide supplied with the projector.

Supply System Error 
(Ballast)

Auto Iris Error

Network error (TCP 
connection error)

Check that the projector's power is turned on 
and the LAN cable is connected, and also 
check that "Network Monitoring" is set to 
"ON" and "Standby Mode" is set to "Network 
ON".

Network error (ESC/
VP.net communication 
error)

Check that the projector has been correctly 
connected to the network.

Network error (monitor 
password authentication 
error)

Check the projector's Monitor Password.

Message Remedy
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You can use the application lock to prevent third parties from operating the 
projectors using EMP Monitor and from changing settings without authority. 
Opening and closing EMP Monitor and status monitoring can still be carried 
out even when the application lock is applied.
In addition, when a password has been set, the password must be entered in 
order to cancel the application lock. This ensures that the application lock can 
not be easily cancelled, and thus improves system security.

Switching application lock between enabled and 
disabled

f Enabling the lock

PROCEDURE

Select "Application lock" from the "Tool" menu.
The application lock will be enabled and no operations will be 
possible other than opening and closing EMP Monitor and disabling 
the application lock.

f Disabling the lock

PROCEDURE

Select "Application unlock" from the "Tool" menu.

The password entry window will be displayed, so 
enter the set password and then click [OK].
If no password has been set (default setting), click [OK] 
without entering a password. It is recommended that you enter a 
password in order to strengthen security.
The application lock will be cancelled and operations can be 
carried out as normal.

Setting a password for cancelling application lock

Carry out the following operations while application lock is cancelled.

PROCEDURE

Select "Environment setup" from the "Tool" menu.
The "Environment setup" window will be displayed.

Select "Change the application lock password".

Enter the password in both the "New password" and 
"New password (confirm)" boxes and then click [OK].
The password can be up to 16 bytes in length. Single-byte 
alphanumeric characters can be used.

1

2

1

2

3
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Projectors cannot be monitored or controlled An e-mail message is not sent when a problem 
occurs with a projector

Cause Remedy
Is the projector connected to 
the network correctly?

Connect the network cable correctly. 
s"Network Cable Connections" in the 
projector's User's Guide

Has the projector been set 
up correctly for connection 
to the network?

Check the settings for the "Network" 
configuration menu command.
sProjector's User's Guide

Has EMP Monitor been 
installed on the computer 
correctly?

Uninstall EMP Monitor and then re-install 
it. 

Are all the projectors that 
you want to control or 
monitor registered?

Register the projectors. sp.7

Is the projector's "Network 
Monitoring" or "Standby 
Mode" configuration menu 
set to "ON" or "Network 
ON"?

In order to use EMP Monitor to monitor 
and control the projector when it is in 
standby mode, the projector's "Network 
Monitoring" or "Standby Mode" 
configuration menu must be set to "ON" or 
"Network ON".
sProjector's User's Guide

Cause Remedy
Is the projector connected to 
the network correctly?

Connect the network cable correctly. 
s"Network Cable Connections" in the 
projector's User's Guide

Has the projector been set 
up correctly for connection 
to the network?

Check the settings for the "Network" 
configuration menu command.
sProjector's User's Guide

Have the SMTP server IP 
address, port number and 
recipient e-mail address all 
been set correctly?

Check the setting details.

Is the projector's "Network 
Monitoring" or "Standby 
Mode" configuration menu 
set to "ON" or "Network 
ON"?

To use the mail notification function while 
the projector is in standby mode, set 
"Network Monitoring" or "Standby Mode" 
to "ON" or "Network ON" in the 
projector's configuration menus.
sProjector's User's Guide

Has a critical problem 
developed causing the 
projector to momentarily 
stop working?

When the projector has momentarily 
stopped working, it cannot send e-mail 
messages. If the projector cannot be reset 
even after it has been checked, contact your 
dealer or the nearest address provided in 
the Support and Service Guide supplied 
with the projector.

Is power being supplied to 
the projector?

Check if the power supply to the location 
where the projector is set up has been 
interrupted, or if the circuit breaker for the 
electrical outlet that the projector is 
connected to has been tripped.
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